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Matrox Software License Agreement 

(Hereafter Referred To As License)

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD 
("MATROX") CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING, 
INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT" BUTTON, OR OTHERWISE USING 
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS LICENSE. IF YOU ARE ACCEPTING 
THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL INSTITUTION, OR 
AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT AS ITS 
AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL 
AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
LICENSE, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED, 
DESTROY ALL COPIES OF THE SOFTWARE.

In this License "Software" refers to: any firmware, software, associated software components, media, printed 
materials, and "online" or electronic documentation related to Matrox products. 

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This License 
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This License 
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or third party software suppliers (if any). 
The present License does not give Licensee any intellectual property rights to the Software or its derivatives. The 
downloading and/or the use of any Software are subject to the following restrictions and limitations: 

LICENSES: 
If you are an end user, the "End User License" shall apply to you.

If you are an original equipment manufacturer (OEM), the "OEM License" shall apply to you. 

END USER LICENSE
1 Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any 

location. The Software is subject to a restricted license therefore Licensee must use the Software on a single 
computer owned or leased by Licensee at a time, in conjunction with and for the purpose of, operating the Matrox 
hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not licensed 
hereunder. Licensee shall also have the right to make one copy of the Software in any computer-readable or printed 
form for back-up or archival purposes;

2 No right to recopy, publish, display, network, rent, loan, lend, assign, sell, distribute, license, sub-license, alter, 
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner 
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or criminal 
penalties, as violators will be prosecuted to the maximum extent possible; 

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the 
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, or to 
use this Software to: (i) develop inventions directly derived from confidential information to seek patent 
protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify Licensee's 
existing patents or patent applications;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the 
purpose of installation, service integration and/or support of said Software within Licensee's product. In such 
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to 
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this License;

5 Licensee may not grant any sublicense, lease or other right in the Software to others;
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6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"), Matrox is 
free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other 
consideration to Licensee;

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent 
notices in the Software. 

OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's product or 
as a standalone Software maintenance update for existing end users of Licensee's products, excluding any other 
standalone products, subject to these conditions:

1 This Software is subject to a restrictive license therefore it is licensed for use only in conjunction with the Matrox 
hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not licensed 
hereunder;

2 No right to recopy, publish, display, sell, network, rent, loan, lend, distribute, license, sub-license, alter, modify, 
disassemble, de-compile, create derivative works or reverse engineer any Software in any manner whatsoever is 
hereby given, except as provided in this License. Violation may result in severe civil and/or criminal penalties, as 
violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the 
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, or to 
use this Software to: (i) develop inventions directly derived from confidential information to seek patent 
protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify Licensee's 
existing patents or patent applications;

4 Licensee may only distribute the Software to Licensee's customers pursuant to a written license agreement. At a 
minimum such license shall safeguard Matrox's ownership rights to the Software and such agreement shall contain 
similar terms and obligations;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the 
purpose of installation, service integration and/or support of said Software within Licensee's product. In such 
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to 
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this License;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"), Matrox is 
free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other 
consideration to Licensee.

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent 
notices in the Software.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)
There are inherent dangers in the use of any software available for downloading on the Internet and Matrox cautions 
Licensee to ensure that Licensee completely understands the potential risks before downloading any of the Software. 
Licensee is solely responsible for adequate protection and backup of the data and equipment used in connection with 
any of the Software, and Matrox will not be liable for any damages that may be suffered in connection with use of the 
Software. 

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically applies, 
without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities. 

In addition, certain third party intellectual property may be provided with or included in the Software. The third party 
license terms accompanying such software, found at http://www.matrox.com/video/licenses and in the license.txt file 
located in the root installation directory, will govern your use of such software. Matrox does not warrant and is not 
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liable for such third party intellectual property. Licensee acknowledges and agrees to comply with the terms of all 
applicable third party software licenses if any. The terms and conditions of third party license agreements may be 
updated from time to time. It is the Licensee responsibility to verify that the agreement listed is current and applicable. 
Please note that this list of third party licenses is not exhaustive and was determined according to Matrox's 
understanding and to the best of its knowledge.

PRE-RELEASE LICENSE EXCLUSION: If you are using a version of the licensed Software that is designated, 
without limitation, as an alpha, beta, engineering sample, preliminary or early access version of the Software, then; (a) 
the Software is deemed to be pre-release code (e.g. alpha or beta, engineering sample, preliminary, early access, etc.), 
which may not be fully functional and which Matrox may substantially modify in development of a commercial 
version, and for which Matrox makes no assurances that it will ever develop or make generally available in a 
commercial version, and (b) Licensee shall have the right to use the Software only for the duration of the pre-release 
term or until the commercial release, if any, of the Software, whichever is shorter. For clarity, a remedy to any bug, 
defect, error or fault in any pre-release version of the Software will absolutely require upgrading to a new version of 
the Software. Matrox reserves the right to change any content of this new version of the Software at its sole discretion. 

COPYRIGHT
All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by Matrox or 
its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the 
Software is the property of the respective content owner and may be protected by applicable copyright or other 
intellectual property laws and treaties. This License grants you no rights to use such content. All rights not expressly 
granted are reserved by Matrox. 

DISCLAIMER OF WARRANTIES
LICENSEE EXPRESSLY ACKNOWLEDGES AND AGREES THAT USE OF THE SOFTWARE IS AT 
LICENSEE'S SOLE RISK. THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY 
KIND AND MATROX EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF ITS SOFTWARE AND ANY THIRD PARTY 
INTELLECTUAL PROPERTY. MATROX DOES NOT WARRANT THAT THE CONTENTS OF THE SOFTWARE 
WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE 
ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE IS ASSUMED BY LICENSEE. 
FURTHERMORE, MATROX DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE 
USE OR THE RESULTS OF THE USE, OF THE SOFTWARE OR ANY THIRD PARTY INTELLECTUAL 
PROPERTY IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR 
OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE PROVE DEFECTIVE, LICENSEE ASSUMES 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT 
APPLY TO LICENSEE. 

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR 
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT 
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT 
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE. 
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED 
HEREIN.

LIMITATION OF LIABILITY
UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES, ITS SUBSIDIARIES BE LIABLE 
FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES 
THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS LIMITATION APPLIES 
WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT 
LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF THE POSSIBILITY OF 
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SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY IN SUCH JURISDICTIONS 
SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW. 

UNAUTHORIZED USE. THIS SOFTWARE RELATED THERETO ARE NOT DESIGNED, INTENDED, 
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM OR 
OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS ENVIRONMENTS 
OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE PERFORMANCE, WHERE 
PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL SYSTEMS, LIFE SUSTAINING, LIFE 
SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR 
COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC WORKS, WEAPONS SYSTEMS, OR ANY 
OTHER APPLICATION IN WHICH THE FAILURE OF A PRODUCT COULD LEAD TO PROPERTY DAMAGE, 
ENVIRONMENTAL DAMAGE, OR PERSONAL INJURY. LICENSEE WILL NOT USE, OR PERMIT TO BE 
USED, THE PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND 
FURTHER, LICENSEE AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS 
MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, ASSIGNS AND 
ITS 3RD PARTY SUPPLIERS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, 
DAMAGES, AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) 
ARISING OUT OF , OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS RELATED HERETO, 
EVEN IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR 
MANUFACTURE OF THE SOFTWARE.

DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITIES FOR THIRD PARTY SOFTWARE 
INCLUDED WITH OR IN THE SOFTWARE. ALL THIRD PARTY SOFTWARE INCLUDED WITH THE 
SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. MATROX AND ITS 3RD PARTY SUPPLIERS MAKE NO 
WARRANTY TO LICENSEE, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND 
NON-INFRINGEMENT, REGARDING ANY THIRD PARTY SOFTWARE, OR ITS USE AND OPERATION 
ALONE OR IN COMBINATION WITH LICENSEE PRODUCTS. NEITHER LICENSEE, NOR ITS EMPLOYEES, 
AGENTS, OR DISTRIBUTORS HAVE ANY RIGHT TO MAKE ANY OTHER REPRESENTATION, WARRANTY 
OR PROMISE WITH RESPECT TO ALL THIRD PARTY SOFTWARE INCLUDED WITH THE SOFTWARE. 

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM AND 
AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY THIRD PARTY PATENT, 
COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY RIGHT. LICENSEE WILL PROMPTLY 
NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM. 

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM AND 
AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT READS UPON OR IS 
INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, TECHNOLOGY OR PATENT STANDARD 
OR RECOMMENDATIONS, INCLUDING WITHOUT LIMITATION AVC/H.264, IEEE 1394, JPEG, JPEG2000 
AND MPEG-4.

IN ANY EVENT, MATROX'S TOTAL CUMULATIVE LIABILITY TO LICENSEE FOR ANY AND ALL CAUSE 
OF ACTION SHALL BE LIMITED TO THE AGGREGATE OF ALL AMOUNTS PAID BY LICENSEE TO 
MATROX, DURING THE TWELVE (12) MONTH PERIOD PRIOR TO OBTAINING A FINAL, 
NONAPPEALABLE JUDGMENT OR $50,000.00 USD, WHICHEVER IS LOWER. THE FOREGOING 
LIMITATIONS WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS ESSENTIAL PURPOSE.

TERMINATION
This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In 
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right 
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee 
violates any of this Licenses' terms and conditions.
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Matrox will not, by reason of the termination of this License, be liable for compensation, reimbursement or damages 
on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments, leases, or 
commitments in connection with the Licensee's business or goodwill or otherwise. If Licensee commences or 
participates in any legal proceeding against Matrox then Matrox may, in its sole discretion, suspend or terminate all 
license grants and any other rights provided under this License during the pendency of such legal proceedings.

MISCELLANEOUS
If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision will be 
construed as limited to the extent necessary to be consistent with and fully enforceable under the law. This License is 
the final, complete and exclusive agreement between the parties relating to the subject matter hereof, and supersedes 
all prior or contemporaneous understandings and agreements relating to such subject matter, whether oral or written. 
This License may only be modified in writing signed by an authorized officer of Matrox. Licensee agrees that it will 
not ship, transfer or export the Software into any country, or use the Software in any manner, prohibited by the United 
States Bureau of Industry and Security and shall fully comply with all United States relevant export laws, restrictions 
or regulations and any other applicable export and import laws. 

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in 
accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive 
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute arising out 
of or in connection with this License.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary notices 
and copyright information, the terms of which must also be observed and followed. 

The failure of Matrox to enforce at any time any of the provisions of this License, or the failure to require at any time 
performance by the Licensee of any of the provisions of this License, shall in no way be construed to be a present or 
future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and every such provision 
thereafter.

Any and all articles and/or sections which by their nature are required to survive termination of this License shall 
survive.

ANY INTERPRETATION OF THE CONTENTS, RIGHTS AND OBLIGATIONS OF THE CONTENTS OF THIS 
NOTICE AND/OR MATROX WEB SITE SHALL BE INTERPRETED IN ACCORDANCE WITH THE LAWS OF 
QUEBEC.

All rights reserved by Matrox. 

Matrox reserves the right to change Software specification without notice. All intellectual property, including without 
limitation, trademarks and copyrights are the property of their respective owners and any unauthorized use thereof is 
strictly prohibited. 

COPYRIGHT © 2015 Matrox is a trademark of Matrox Electronic Systems Ltd.
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mvTopologyBuilder User Interface

Overview
This chapter provides an overview 
of the mvTopologyBuilder window 
and explains the Main menu, Main 
toolbar, Topology view, Item tree, 
mvTopologyBuilder panes, 
Permanent memory manager, 
and mvTopologyBuilder Crash me 
tool.Prel
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About mvTopologyBuilder
The mvTopologyBuilder application provides a graphical representation of 
topology-based interfaces for controlling Matrox hardware. It allows users to control 
all the I/O and hardware-related operations for topology-based hardware, such as 
X.mio3 and DSX LE4. For details on the Matrox topology-based API and a 
description of the topology-based terminology, see the Matrox DSX Topology API 
User Guide.

The mvTopologyBuilder application is a diagnostic tool designed to create and 
manage topologies that represent specific workflows. You can also intentionally crash 
the application to ensure that faulty behavior is reported properly. 

This chapter provides details about the mvTopologyBuilder interface. For information 
on how to use mvTopologyBuilder to create a new system topology and add items to 
it, see Chapter 2, “Using mvTopologyBuilder to Manage Topologies,” on page 23. For 
system topologies examples, see Chapter 3, “Working with System Topologies,” on 
page 77.
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Overview of the mvTopologyBuilder window
The mvTopologyBuilder window consists of a Main menu, a Main toolbar, an Item 
tree, several panes, and a Topology view.

mvTopologyBuilder window
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The following is a brief overview of the mvTopologyBuilder window:

• Main menu This menu allows you to perform basic operations (see “Using the 
Main menu” on page 5).

• Main toolbar This toolbar provides a shortcut to common operations such as 
creating a new topology, opening a topology, and saving a topology (see “Using 
the Main toolbar” on page 7).

• Topology view This view displays the items contained in a topology that has 
been created (see “Using the Topology view” on page 8).

• Item tree This displays all the items that can be added to a topology (see 
“Using the Item tree” on page 9).

• Card pane This pane displays, in a tree structure, the available cards that are 
supported by the API along with topologies, software clocks, and watchdogs (see 
“Card pane” on page 15).

• Performance pane This pane displays the Matrox Control Engine (MCE) 
workload performance of the selected card (see “Performance pane” on page 17).

• Time code pane This pane displays the time code values of all the created 
input streams and the time code from a time code input connector that is available 
on certain cards (see “Time code pane” on page 18).

• Log pane This pane displays messages from the application in a log window 
(see “Log pane” on page 19).

• Memory manager pane This pane displays the amount of memory used (in 
MB) for the current process.

• Transport pane This pane is used to control the reader stream, writer stream, 
encoder stream, decoder stream, and RTP receiver stream (see “Transport pane” 
on page 16).

• Properties pane This pane displays the settings of the currently selected item 
in the Topology view or Card pane (see “Properties pane” on page 17).
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Using the Main menu
The Main menu allows you to perform basic operations and contains the File, View, 
Topology, Insert item, Window, Tools, and Help menus (see figure 
“mvTopologyBuilder window” on page 3).

File menu
The File menu contains operations for creating, opening, and saving a topology, as 
well as the option to exit the application.

Note Creating, opening, and saving a topology are also available in the Main 
toolbar. For more information on the Main toolbar, see “Using the Main toolbar” on 
page 7.

View menu
The View menu allows you to open a Live window if it has been closed in the 
Topology View. 

Topology menu
The Topology menu allows you to perform specific operations on the current 
topology. 

The Refresh document option updates the settings of the current topology.

The Refresh properties option updates the settings of all topologies of the currently 
selected card.

The Play/record all option plays back or encodes certain streams of the current 
topology. The playback and encoding are synchronized to the same time stamp. You 
can also click Play/record all in the Main toolbar, or to playback or encode the 
selected stream only, click Play ( ) or Record ( ) in the Transport pane.

The Stop all play/record option stops all playback or encoding of the current 
topology. You can also click Stop all in the Main toolbar, or to stop the playback or 
encoding of the selected stream only, click Stop ( ) in the Transport pane.

The Add to default state option adds the current topology to the default state of the 
card. For more information on the default state, see “Working with the default state of 
the card” in the Matrox DSX Topology API User Guide.

The Destroy topology option destroys the current topology from the card. For more 
information on the different ways that you can destroy a topology, see “Destroying a 
topology” on page 6.
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Insert item menu
The Insert item menu can be used to add an item to a topology. The items that can be 
added are: CG stream, link node, Live window, AES/EBU input, AES/EBU output, 
SDI input, SDI output, alias card node, card node, compressed host node, host node, 
shared host node, compressed writer stream, decoder stream, de-interlacer stream, 
echo stream, encoder stream, input stream, mixer stream, muxer stream, output 
stream, reader stream, RTP receiver stream, RTP sender stream, transfer stream, 
transform stream, and writer stream.

Note Items can also be added using the Item tree. For more information on the 
different ways that items can be added to a topology, see “Adding items to a topology” 
on page 4.

Tools menu
The Tools menu can be used to manage the permanent memory and contains utility 
methods used for debugging. The log file can be enabled or disabled. You can search 
for a particular log file, and the topology can be tested using Crash me. For more 
information on managing the permanent memory, see “Using the Permanent memory 
manager” on page 20. For more information on the Crash me, see and “Using the 
mvTopologyBuilder Crash me tool” on page 22.

Help menu
The Help menu contains information about short cuts and the application version.
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Using the Main toolbar
The Main toolbar provides shortcuts to common operations. The following items are 
found on the Main toolbar (see figure “mvTopologyBuilder window” on page 3):

• New topology Creates a new topology (see “Creating a new topology” on 
page 3).

• Open Opens an existing topology from an .mvst file. For the different ways to 
open an existing topology, see “Loading a topology” on page 6.

• Save Saves all the settings of all the items of a topology to an .mvst file. For the 
different ways to save a topology, see “Saving a topology” on page 5.

• Destroy topologies on close Sets all topologies to Destroy on close. The 
next time any topology is closed, it will be destroyed.

• Fit Positions all the items in the current topology within the Topology view. 

• Place all Positions all the items in the current topology in an orderly fashion in 
the Topology view window. 

• Play/record all Plays back or encodes certain streams of the current topology. 
The playback and encoding are synchronized to the same time stamp. You can 
also choose Topology > Play/record all, or to playback or encode the selected 
stream only, click Play ( ) or Record ( ) in the Transport pane.

• Stop all Stops all playback or encoding of the current topology. You can also 
choose Topology > Stop all play/record, or to stop the playback or encoding 
of the selected stream only, click Stop ( ) in the Transport pane.

• Genlock resolution, Genlock source, and Genlock status Use these 
settings to select a genlock resolution and genlock source, and check the status of 
the genlock for the currently selected card in the Card pane. For more 
information on the genlock, see “Using genlock control” in the Matrox DSX 
Topology API User Guide. You can also use the Properties pane to select the 
genlock settings (see “Properties pane” on page 17).
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Using the Topology view
The Topology view displays all the items contained in a topology and is positioned in 
the center of the mvTopologyBuilder window (see figure “mvTopologyBuilder 
window” on page 3). If more than one topology is open at the same time, each 
topology will be placed in a separate tab. 

Note When an item in a topology is selected, the Properties pane reflects the 
settings of the currently selected item. For more information on the Properties pane, 
see “Properties pane” on page 17.

Zooming in or out of the Topology view
• Press CTRL, then using the mouse wheel:

$ Scroll up to zoom in.

$ Scroll down to zoom out.

Moving the Topology view left or right
• Press SHIFT, then using the mouse wheel:

$ Scroll up to move the Topology view to the right.

$ Scroll down to move the Topology view to the left.

• Drag the background of the Topology view to the left or to the right.

Moving the Topology view up or down
• Using the mouse wheel:

$ Scroll up to move the Topology view down.

$ Scroll down to move the Topology view up.

• Drag the background of the Topology view up or down.

Connecting items in the Topology view
• Drag an item’s output to another item’s input. 

Note When dragging from an item’s output, a connecting line will appear. If the 
line is red, the connection is not good. If the line is white, the connection is good.

Disconnecting items in the Topology view
• Select the item’s connection and press DELETE. 

For information on creating a topology, adding items, placing items, deleting items, 
playing a topology, saving a topology, loading a topology, closing a topology, and 
destroying a topology, see “Creating a new topology” on page 3.
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Using the Item tree
The Item tree displays all the items that can be added to a topology. There are five 
categories of items that can be added (see figure “mvTopologyBuilder window” on 
page 3):

• Application items The application items represent software modules 
implemented only in the mvTopologyBuilder application that interact with the 
topology. These items send or retrieve data to or from the nodes in the topology. 
The application items consist of the CG stream, link node, and Live window. For 
more information, see “Application items” on page 9.

• Connector items The connector items represent available input and output 
connectors present on the card that can be added to a topology, and consist of SDI 
inputs, SDI outputs, AES/EBU audio inputs, and AES/EBU audio outputs. For 
more information, see “Connector items” on page 11.

• Node items The node items represent the different types of nodes that can be 
added to a topology and consist of the alias card node, card node, compressed 
host node, host node, and shared host node. For more information, see “Node 
items” on page 12

• Hardware stream items The hardware stream items represent hardware 
processing units on the card that can be added to a topology and consist of the 
input stream, output stream, transform stream (if created between two card 
nodes), mixer stream, and de-interlacer stream. For more information, see 
“Hardware stream items” on page 13.

• Software stream items The software stream items represent CPU processing 
units available in the DSX.sdk that can be added to a topology and consist of the 
compressed writer stream, decoder stream, echo stream, encoder stream, muxer 
stream, reader stream, RTP receiver stream, RTP sender stream, transfer stream, 
transform stream (if created between two host nodes), and writer stream. For 
more information, see “Software stream items” on page 13.

Application items
Application items represent software modules implemented only in the 
mvTopologyBuilder application that interact with the topology. These items send or 
retrieve data to or from nodes in the topology.

Remarks
• Application items do not reside in the card. Therefore, they cannot be saved to 

the default state of the card.

• Once an application item is added, it cannot be disconnected. However, it can be 
connected to a different item.
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The application items that can be added consist of the following:

• CG stream Generates video from a graphic file (such as .422, .bmp, .mgf, and 
.tga files), constant color, or a string. Audio data can be generated at a different 
intensity, frequency, and phase on all 16 channels. The CG stream can also 
generate test VITC and LTC time code data. As well, it can generate a moving 
bar over a black background. For information on creating a CG stream, see 
“Creating a CG stream” on page 20.

• Link node Accesses data from a host node in any topology of the same 
process. For information on creating a link node, see “Creating a node” on 
page 31.

• Live window Displays the contents of a node. For more information on this 
item, see “Live window item” on page 10.

Live window item
The Live window item is used to display the content of a node. It can be used to 
display video, alpha (key), VANC, time code, and monitor audio levels (through VU 
meters or a waveform). For more information on creating a Live window, see 
“Creating a Live window” on page 73. 

Note Once a Live window is added, it cannot be disconnected. However, it can be 
connected to the output of a different node.

The Live window contains the following four areas:

0 Toolbar Use the toolbar to select the display mode.

1 Data area Displays the node content. The data that is displayed depends on the 
display mode selected in the toolbar.

0

1

2

3 Prel
im

ina
ry
pter 1, mvTopologyBuilder User Interface Overview



11
2 Color picker Displays the color values used at the coordinates the mouse 
pointer hovers over.

3 Information area Displays the time code associated with the node content.

The Live window retrieves only data specified in the Properties pane. For more 
information on using the Properties pane, see “Properties pane” on page 17. The Live 
window data area uses OpenGL to draw the data.

The toolbar contains the following buttons:

•  Video Displays the video content of the node. 

•  Time code Displays the time code information associated with the node 
content. 

•  Alpha channel Displays the alpha (key) channel of the node image. 

•  VANC Displays the actual digital information of the VANC data. The 
VANC data is not interpreted. 

•  Waveform Displays the audio waveform. 

•  VU meters Shows or hides the audio levels through VU meters.

•  Freeze Freezes or unfreezes a frame in the Live window. When a video 
frame is frozen, the state of the frame can be viewed.

•  Scale factor Zooms in or out of the video or key data. When zoomed 
in, you can drag the image to see the other parts of the image.

Note When the data area of the Live window displays video or key data, you can 
use the mouse wheel to zoom in and out of the image to monitor specific pixels of the 
image more precisely. When zoomed in, you can drag the image to see the other parts 
of the image.

Connector items
Connector items represent the physical connections on the card. The connector items 
that can be added to a topology consist of the following:

• SDI In Represents an SDI input connector on the card. The connector transmits 
the SDI data stream including the video, audio, VANC, and time code to an input 
stream.

• SDI Out Represents an SDI output connector on the card. This item takes data 
from an output stream and sends it to the proper SDI output connector.

• AES/EBU In Represents an AES/EBU input connector on the card. The 
connector transmits an AES/EBU audio data pair to the input stream and replaces 
an embedded SDI audio pair.

• AES/EBU Out Represents an AES/EBU output connector on the card. This 
item takes audio data from an output stream and sends it to the proper AES/EBU 
output connector.
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When you create an input or output stream, the selected SDI input or output connector 
is automatically added to the topology and connected to the stream. If you want to 
also use an AES/EBU input or output connector, you must manually add the 
connector and connect it to the stream. For information on adding connector items to 
a topology, see “Adding items to a topology” on page 4. 

When a connector item is added, it does not need to be connected. However, an input 
connector can only be connected to an input stream and an output connector can only 
be connected to an output stream. You cannot delete a connector from a topology 
when it is connected to a stream. To delete the connector, you must first delete the 
stream to which it is connected (see “Deleting items in a topology” on page 5).

When adding a connector to a topology, the Properties pane shows the connector’s 
properties. For more information on using the Properties pane, see “Properties pane” 
on page 17.

Node items
A node item is an element in a system topology that contains video, audio, and VANC 
data. The data contained in the node is received by a maximum of three streams and 
passed to one or more streams. It is a connection point between streams. Depending 
on the type of node, the node’s data can be located in host memory or a card’s 
onboard memory. For more information on creating a node, see “Creating a node” on 
page 31.

The different types of node items that can be added to a system topology consist of 
the following:

• Alias card node Represents a read-only card node that is used to access the 
data contained in a card node owned by another or the same process.

• Card node Represents a node located in a card’s onboard memory.

• Compressed host node Represents a node located in host memory that 
contains compressed video data, compressed audio data, compressed VANC data, 
or transport stream (TS) muxed buffers.

• Host node Represents a node located in host memory.

• Shared host node Represents a node located in host memory that is used to 
access host node data from other processes.

Note Host nodes, compressed host nodes, and shared host nodes do not reside in 
the card. Therefore, they cannot be saved to the default state of the card.
Prel
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Hardware stream items
Hardware stream items represent physical hardware present on the card that can be 
added to a topology. 

The hardware items that can be added consist of the following:

• Input stream Represents one input channel on a card. An input stream 
receives data from an input connector and sends it to a node. For information on 
creating an input stream, see “Creating an input stream” on page 37.

• Output stream Represents one output channel on a card. An output stream 
receives data from a node and sends it to an output connector. For information on 
creating an output stream, see “Creating an output stream” on page 41.

• Transform stream Processes data from one card node and sends it to another 
card node. A transform stream can include in-line processing such as scaling, 
processing ancillary data, and copying audio. For information on creating a 
transform stream, see “Creating a transform stream” on page 45.

• Mixer stream Mixes video from multiple nodes into one node to perform 
video compositing. Audio and VANC data can be copied from any of the sources 
to the node containing the composited video. For information on creating a mixer 
stream, see “Creating a mixer stream” on page 48.

• De-interlacer stream Takes interlaced video data from a card node, modifies 
the video data to remove interlace or motion artifacts, and sends the result to 
another card node containing progressive video data. Audio and VANC data can 
be copied from the input card node to the output card node containing the 
progressive video data. For information on creating a de-interlacer stream, see 
“Creating a de-interlacer stream” on page 58.

Software stream items
Software stream items represent CPU processing units available in the DSX.sdk that 
can be added to a topology.

Remarks
• Software stream items do not reside in the card. Therefore, they cannot be saved 

to the default state of the card.

• Once a software stream item is added, it cannot be disconnected. However, it can 
be connected to a different item.

The software items that can be added consist of the following:

• Compressed writer stream Takes compressed video, audio, and VANC data 
from a compressed host node, and writes it to a file. For information on creating a 
compressed writer stream, see “Creating a compressed writer stream” on 
page 56.

• Decoder stream Uncompresses video, audio, and VANC data from a 
compressed host node using a supported decoder, and sends it to a host node. For 
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information on creating a decoder stream, see “Creating a decoder stream” on 
page 57.

• Echo stream Propagates VANC data from a compressed host node to a host 
node without altering the data, and vice-versa. For information on creating an 
echo stream, see “Creating an echo stream” on page 60.

• Encoder stream Compresses video, audio, and VANC data from a host node 
using a supported encoder, and sends it to a compressed host node. For 
information on creating an encoder stream, see “Creating an encoder stream” on 
page 61.

• Muxer stream  Multiplexes compressed video, audio, and VANC elementary 
streams from compressed host nodes into a single MPEG-2 program transport 
stream (SPTS) muxed buffer, and sends it to a compressed host node. For 
information on creating a muxer stream, see “Creating a muxer stream” on 
page 62.

• Reader stream Reads video, audio, and VANC data from a file, decompresses 
it, and sends it to a host node. The reader stream can read different file types in 
sequence, as long as the frame rate of the file is the same as the frame rate of the 
host node and a suitable decompressor is available. For information on creating a 
reader stream, see “Creating a reader stream” on page 51.

• RTP receiver stream Receives compressed MPEG-2 transport stream (TS) 
data from a specified IP address and sends it to a compressed host node. For 
information on creating an RTP receiver stream, see “Creating an RTP receiver 
stream” on page 67.

• RTP sender stream Transforms a stream containing TS packets from a 
compressed host node into RTP packets, and then sends the packets to the 
specified IP address (IPV4) using UDP (User Datagram Protocol). For 
information on creating an RTP sender stream, see “Creating an RTP sender 
stream” on page 65.

• Transfer stream Takes video, audio, and/or VANC data from a node and 
transfers it to a another node at a different memory location. The input node 
settings and the output node settings must be the same. The data is copied 
without any modification. For information on creating a transfer stream, see 
“Creating a transfer stream” on page 69.

• Transform stream Processes data from one host node and sends it to another 
host node. A transform stream can include in-line processing such as scaling, 
processing ancillary data, and copying audio. For information on creating a 
transform stream, see “Creating a transform stream” on page 45.

• Writer stream Takes video, audio, and VANC data from a host node, 
compresses it, and writes it to a file. The writer stream can be configured to 
compress the video data only, the audio data only, the video and audio data, the 
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video and VANC data, or the video, audio, and VANC data. For information on 
creating a writer stream, see “Creating a writer stream” on page 53.

Using the mvTopologyBuilder panes
The mvTopologyBuilder panes allow you to configure items in the API, as well as 
provide feedback concerning hardware events. The mvTopologyBuilder panes consists 
of a Card pane, Transport pane, Properties pane, Performance pane, Time code pane, 
Log pane, and Memory manager pane. The following sections provide more detail on 
each of these panes.

Card pane
The Card pane displays, in a tree structure, the available cards that are supported by 
the API along with system topologies, software clocks, and watchdogs. When an item 
in the tree structure is selected, information related to the selected item is displayed in 
the Properties pane. Depending on the item that is selected, different properties will 
be displayed in the Properties pane. For more information on the Properties pane, see 
“Properties pane” on page 17.

The toolbar in the Card pane contains the following buttons:

•  Refresh all Updates the settings of all topologies by querying the 
currently selected card.

•  Topology menu:

$  Open Opens the currently selected topology in the Topology view. For 
different ways to open an existing topology, see “Loading a topology” on 
page 6.

$  New Creates a new topology. For more information on how to create a 
new topology, see “Creating a new topology” on page 3.

$  Destroy Destroys the currently selected topology from the card. For 
different ways to destroy a topology, see “Destroying a topology” on page 6. 
This button is available only when a topology is currently selected.

•  Watchdog menu:

$  New Creates a new watchdog. For more information on creating a 
watchdog, see “Creating a watchdog” on page 24.

$  Destroy Destroys the currently selected watchdog from the card. This 
button is available only when a watchdog is selected.

•  Software clock menu:

$  New rendering Creates a new rendering clock. For more information 
on creating a rendering clock, see “Creating a new rendering clock” on 
page 25.

$  New universal Creates a new universal clock. For more information 
on creating a universal clock, see “Creating a new universal clock” on page 26.
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$  Destroy Destroys the currently selected clock. This option is available 
only when after a rendering clock or universal clock is created.

Transport pane
The Transport pane is used to control the reader stream, writer stream, encoder 
stream, decoder stream, and RTP receiver stream (see figure “mvTopologyBuilder 
window” on page 3). Different controls are available depending on the stream that is 
selected. 

Note The Transport pane can only be used if a stream is selected.

Transport pane for the reader stream
When a reader stream is selected, the Transport pane contains the following buttons:

•  Play Plays back the reader stream of the current topology.

•  Pause Pauses the playback of the reader stream.

•  Stop Stops the playback of the reader stream.

•  Next frame Skips to the next frame in the playback.

•  Previous frame Rewinds to the previous frame in the playback.

•  Start of file Goes to the start of the file.

•  End of file Goes to the end of the file.

•  Scrubbing bar Drag the slider to go to a specific frame in the file.

Transport pane for the writer, encoder, decoder, and RTP 
sender stream
When a writer stream, encoder stream, decoder stream, or RTP receiver stream is 
selected, the Transport pane contains the following buttons:

•  Record Encodes or decodes the stream of the current topology.

•  Stop Stops the encoding or decoding of the stream.
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Properties pane
The Properties pane displays the settings of the currently selected item in the topology 
(see figure “mvTopologyBuilder window” on page 3). Depending on the item that is 
selected, different properties will be displayed in the Properties pane. The Properties 
pane can be used to view the properties of the selected item, as well as edit the 
properties that were defined when the item was created. For some items, you can 
define additional properties that were not available when the item was created.

Note You may be required to expand the properties in the Properties pane to view 
or edit the settings.

The Properties pane contains the following button:

•  Refresh Refreshes the properties in the Properties pane to show the values 
that are currently being used in the hardware.

Performance pane
The Performance pane displays the Matrox Control Engine (MCE) workload 
performance of an X.mio2 Plus card (see figure “mvTopologyBuilder window” on 
page 3). As you perform operations on this card, the Performance pane displays the 
current workload performance of the MCE in a graph. Certain operations, such as 
adding a topology to the default state requires a greater workload, while other 
operations require a smaller workload. The performance of all operations on the card 
are reflected in a graphical representation in the Performance pane.

Note If the card is other than an X.mio2 Plus, the Performance pane will not 
display anything in the graph.
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Time code pane
The Time code pane displays the time code values of all the created input streams and 
allows you to see the time code from the time code input connector that is available on 
certain cards (see figure “mvTopologyBuilder window” on page 3). For more 
information on time code, see the Matrox DSX Topology API User Guide.

The Time code pane contains the following:

•  Reset drift Resets the time code drift calculation to zero.

•  Pause Freezes or unfreezes the update of the time code value.

• Card Displays the card for which the time code information is displayed.

• Time code source Use this to select the time code source. The different 
sources are the linear time code (LTC) input and the black burst reference input. 
The LTC input source extracts the analog LTC, whereas the black burst reference 
input source extracts vertical interval time code (VITC).

• Time code Displays the time code of the currently selected card.

• Sample time stamp Displays the system time corresponding to the time code 
displayed.

• Drift Displays the difference in time between the system time and the time 
code of the card.

• LTC Indicates whether or not LTC is present.

• LTC value Displays the SMPTE 12M-2 LTC value.

• VITC Indicates whether or not VITC is present.

• VITC value Displays the SMPTE 12M-2 VITC value.

• Analog LTC Indicates whether or not analog LTC is present.
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• Analog LTC value Displays the SMPTE 12M-1 analog LTC value.

Log pane
The Log pane displays messages from the application (see figure 
“mvTopologyBuilder window” on page 3). It displays error codes of calls that failed, 
status messages, and information messages.

The Log pane contains the following buttons:

• Clears the currently displayed messages in the Log pane. 

• Saves the Log pane messages to a log file. 

• Stops sending Log pane messages to a log file.

• Selects the file name and location of the log file that you would like to 
save.

Remarks
• The Log pane displays the last 2 MB of text.

• The speed of incoming log messages may be faster than the speed that they can 
be displayed. In this case, the messages accumulate until they can be processed. 
However, if more than 1000 messages accumulate, the log window will skip 
displaying them. However, if you enable saving the Log pane messages to a log 
file, all messages automatically get saved to a log file. No messages are dropped 
from the log file even if you clear the Log pane window.

• Each time you would like to create a new log file, click Enable log to file. The 
file name of the new log file is displayed in the Log pane, and contains the date 
and time it was created.

Memory manager pane
The Memory manager pane displays the amount of memory used (in MB) for the 
reader stream, writer stream, and any compressed host node (see figure 
“mvTopologyBuilder window” on page 3). As operations are performed, the Memory 
manager pane displays the amount of memory used in a graph. 

To display the amount of memory used in the graph:

• Click Start.

The graph displays the amount of memory (in MB) being used (as a function of 
time). The table on the right is updated with the maximum value (in MB) that can 
be displayed in the graph, the amount of memory currently being used, the 
maximum memory size that can be allocated, and the timeout value.

Note To stop displaying the amount of memory being used, you can click 
Stop at any time.
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To modify the Memory manager graph settings:

1 Click Configure. The Memory manager options dialog box opens.

2 In the Max size to allocate box, enter the maximum amount of memory (in 
MB) that you would like to allocate. This value is displayed on the y-axis of the 
graph.

3 In the Timeout box, enter the amount of time to wait (in milliseconds) before the 
application requests for more memory to be allocated if the maximum amount of 
memory to allocate has been surpassed. 

4 Click OK.

The y-axis of the graph is modified to display the maximum value (in MB) that 
was entered. The legend on the right is updated with the maximum value that can 
be displayed in the graph and the timeout (in milliseconds).

To change the time at which the data in the graph is refreshed:

• Drag the Refresh rate slider.

The data in the graph can be refreshed at any time between 0.02 to 2 seconds.

Using the Permanent memory manager
The Permanent memory manager is used to add or remove topologies and watchdogs 
to or from the default state. As well as save or clear the default state to or from the 
permanent memory of the card. On an X.mio2 Plus card, node content can be saved to 
or removed from the permanent memory of a card. For more information on the 
default state and the permanent memory of a card, see “Working with the default state 
of the card” in the Matrox DSX Topology API User Guide.Prel
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To use the Permanent memory manager:

1 Choose Window > Permanent memory manager. The Permanent memory 
manager dialog box opens.

2 From the Card list, select the card whose permanent memory you would like to 
modify.

The topologies and watchdogs available to be added or removed from the default 
state appear under Topologies and Watchdogs, respectively. If you selected an 
X.mio2 Plus card, available card nodes will appear under Topology nodes.

3 If required, click any of the following:

$ Under Topologies and Watchdogs:

•  Add to default state Adds the currently selected topology or 
watchdog to the default state.

•  Remove from default state Removes the currently selected 
topology or watchdog from the default state.

$ Under Topology nodes:

•  Save to permanent memory Saves the currently selected card node 
to the permanent memory of the card.

•  Remove from permanent memory Removes the currently selected 
card node from the permanent memory of the card.

$  Save Saves the default state to the permanent memory of the card. 

$  Clear Clears the default state from the permanent memory of the card.
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Remarks
$ Topologies and watchdogs are added to or removed from the default state in 

MCE memory.

$ Node content is saved to or removed from the permanent memory. Because 
saving or deleting node content is not instantaneous, a dialog box appears to 
show the progress of the operation.

$ Saving or clearing the default state to or from permanent memory is not 
instantaneous. When Save or Clear is clicked, a progress dialog box appears.

Using the mvTopologyBuilder Crash me tool
The mvTopologyBuilder Crash me tool allows you to crash the application so that you 
can test the watchdog behavior. 

To use the Crash me tool:

1 Choose Tools > Crash me. The Crash me dialog box opens.

2 In the Timeout value box, enter the amount of time to wait (in seconds) before 
the application crashes.

3 Click OK.

Once the timeout has elapsed, the application does a NULL pointer access which 
causes it to throw an exception error resulting in a crash. If the watchdog has 
been configured properly, the watchdog will be triggered.
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Using mvTopologyBuilder to Manage

Topologies
This chapter explains how to use 
mvTopologyBuilder to create a 
new system topology and add 
items to it.
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Overview
Before creating a topology using mvTopologyBuilder, you must select the genlock 
resolution and source. After you have selected the genlock resolution and source, you 
can create a new topology and add items to it. In most cases, the first item that must 
be added to a topology is a node. After adding a node, other items can be added. You 
can save and load a topology at any time. You can also delete a topology when it is no 
longer needed.

Selecting the genlock settings
In mvTopologyBuilder, you must select the genlock resolution and source before 
creating or opening a topology. For more information on genlock, see “Using genlock 
control” in the Matrox DSX Topology API User Guide.

To select the genlock settings:

1 In the Card pane, select the card for which you would like to select the genlock 
settings (if required, refer to the figure “mvTopologyBuilder window” on 
page 3).

2 Do one of the following to select the genlock settings:

$ In the Main toolbar, select the genlock resolution and source from the 
Genlock resolution list and Genlock source list.

$ In the Properties pane, expand Genlock settings (if required) and select the 
genlock resolution and source from the Resolution list and Source list.

The genlock resolution and source are set for the selected card.
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Creating a new software clock
If you would like to use a software clock, such as a rendering clock or universal clock, 
it must be created before creating a new system topology. Otherwise, it will not be 
available for selection when defining the new topology’s settings. For more 
information on the DSX system clock, see “DSX System Clock” in the Matrox DSX 
Topology API User Guide.

Creating a new rendering clock
1 In the Card pane, select the card for which you would like to create a rendering 

clock (if required, refer to the figure “mvTopologyBuilder window” on page 3).

2 Select New rendering ( ) from the Software clock menu ( ). 

The New rendering clock settings dialog box opens.

3 In the Rendering clock name box, enter a name for the rendering clock.

4 From the Speed list, select the speed at which you would like the rendering 
clock to operate.

Note The possible values are one, two, four, or eight times the speed of the 
genlock.

5 Click OK. 

A new rendering clock is added below the selected card in the Card pane.
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Creating a new universal clock
1 In the Card pane, select the card for which you would like to create a universal 

clock (if required, refer to the figure “mvTopologyBuilder window” on page 3).

2 Select New universal ( ) from the Software clock menu ( ). 

The New universal clock settings dialog box opens.

3 In the Universal clock name box, enter a name for the universal clock.

4 In the Time server box, enter the IP address (IPV4, such as 172.17.1.20) or the 
host address (such as time.aserver.com) that will be used by the universal clock.

5 From the Resolution list, select the resolution for the universal clock.

6 Click OK. 

A new universal clock is added below the selected card in the Card pane.
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Creating a new system topology
After selecting the genlock resolution, you can create a new system topology. For 
more information on topologies, see “Creating system topologies” in the Matrox DSX 
Topology API User Guide.

To create a new topology:

1 Do one of the following to open the New topology settings dialog box (if 
required, refer to the figure “mvTopologyBuilder window” on page 3):

$ Choose File > New.

$ In the Main toolbar, click New topology.

$ In the Card pane toolbar, select New from the Topology menu ( ).

2 In the Topology name box, enter a name for the topology. 

3 From the Card profile(s) list, select the card for which you would like to create 
the topology.

4 From the Usable clock(s) list, select the clock source you would like to use.

Remarks
$ When a genlock clock is selected as the clock source, the genlock resolution 

cannot be changed after the topology is created. The only way to change the 
genlock resolution is to destroy the topology and create a new topology with 
the required genlock resolution.

$ If you create a topology using an input system clock, you will not be able to 
add an output stream to the topology.

5 If you would like to destroy the topology when you close the Topology view, 
select Destroy on close.
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6 Click OK. 

A new topology is created, and is displayed in the Topology view and in a tree 
structure below System Topologies in the Card pane.

Note If you would like to add or remove a topology to or from the default state of a 
card, see “Using the Permanent memory manager” on page 20.

Adding items to a topology
Once a topology is created, items can be added to it. You can use the Insert item menu 
or the Item tree to add items to a topology.

Note Depending on the workflow that you are creating, you may be required to 
add a node as the first item in your topology. Once a node is added, other items can be 
added.

To use the Insert item menu to add an item to a topology:

• Choose Insert item, and then select the item that you would like to add. 

The item’s settings dialog box opens.

To use the Item tree to add an item to a topology, do one of the following:

• Double-click the item.

• Drag the item into the Topology view.

The item’s settings dialog box opens.

Once the item’s settings dialog box opens, the settings can be defined and the item can 
be created. For more information on creating the different items, refer to the 
appropriate item creation topic in the following sections.

Note After an item is created, except for nodes, the item’s properties can be edited 
using the Properties pane. For more information on the Properties pane, see 
“Properties pane” on page 17.

Placing items in a topology
After an item is created, it appears in the Topology view. The item is inserted in the 
Topology view according to the manner in which it is created and may not be placed 
in the best viewable manner. 

To place items in a topology, do one of the following:

• Choose Place all in the Main toolbar. All the items are positioned in an orderly 
manner within the Topology view.

• Drag the items into the order you want in the Topology view.
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Deleting items in a topology
If an item is no longer needed in a topology, it can be deleted. 

To delete an item:

• Select the item and press DELETE.

Note A node cannot be deleted when it is connected to a stream.

To delete a node that is connected to a stream:

1 Delete the stream or connect the stream to another node.

2 Select the node to delete and press DELETE.

Playing/recording items in a topology
After a topology is created, items in the topology can be played/recorded. Some items 
start processing automatically after they are added to the topology. Items that do not 
do this, must be played/recorded.

To play/record items in a topology, do one of the following:

• Choose Topology > Play/record all.

• In the Main toolbar, click Play/Record all.

• In the Topology view, click the item that you would like to play/record, and in the 
Transport pane, click Play ( ).

Saving a topology
A topology can be saved at any time. Saving a topology saves all the settings of all the 
items in the topology to an .mvst file. However, it will not save the genlock and 
watchdog settings of the card.

Note An .mvst file is an XML representation of all the settings of all the items in 
the topology.

To save a topology: 

1 Do one of the following to open the Save topology dialog box:

$ Choose File > Save.

$ In the Main toolbar, click Save.

2 In the File name box, enter a file name for the topology and specify the location 
where you would like to save the topology.

3 Click Save.

The topology is saved to an .mvst file.

Note The topology name and the .mvst file name do not have to be the same.
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Loading a topology
When a topology is loaded, a new topology is created in the Topology view with all 
the settings of all the items saved in the topology of the .mvst file. 

To load an existing topology, do one of the following:

• Choose File > Open.

• In the Main toolbar, click Open.

Note If you make modifications to a topology after loading it and would like to 
keep the changes, make sure that you save the topology because you will not be asked 
if you want to save the topology before it is closed.

Closing a topology in the Topology view
When a topology in the Topology view is closed, hardware items will not be 
destroyed from the card unless you selected Destroy on close when the topology 
was created.

To close a topology in the Topology view:

• If Destroy on close was not selected when the topology was created, click the 
Close button ( ) in the Topology view tab.

Note When a topology is closed, application items (such as CG streams, link 
nodes, and Live windows) will be destroyed.

Destroying a topology
When a topology is destroyed, all the items in the topology are automatically 
destroyed. This eliminates the need to destroy all the items in the topology before 
destroying the topology.

To destroy an existing topology, do one of the following:

• In the Card pane, select Destroy from the Topology menu ( ).

• Choose Topology > Destroy topology.

• If Destroy on close was selected when the topology was created, click the Close 
button ( ) in the Topology view tab.Prel
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Creating a node
After creating a new topology, you can start adding items to it. Most items require a 
node before they can be created. The types of nodes that can be added are:

• card node

• host node

• compressed host node

• alias card node

• shared host node

• link node

For more information on nodes, see “Creating nodes” in the Matrox DSX Topology 
API User Guide.

Remarks
• Once a node is created, the node’s properties cannot be changed.

• The maximum number of card nodes and alias card nodes that can be allocated in 
all system topologies on a card is limited to the card’s onboard memory, whereas 
the maximum number of host nodes, compressed host nodes, and shared host 
nodes that can be allocated is limited to the amount of memory that can be 
allocated by the process.

• An alias card node and a shared host node are used to access data from other 
processes.

• A link node is not part of the Matrox DSX Topology API. It is only available in 
the mvTopologyBuilder application and is used to access data from a host node in 
any topology of the same process.
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Creating a card, host, or shared host node
1 Add a card, host, or shared host node. For information on the different ways to 

add a node, see “Adding items to a topology” on page 28. 

The New card node settings (for a card node), New host node settings (for 
a host node), or New shared host node settings (for a shared host node) 
dialog box opens.

2 In the Node name box, enter a name for the node.

3 From the Memory location list, select the location in which to save the node’s 
data. 

In the case of a card node, the card node’s data is saved to the card’s onboard 
memory. Whereas, the host node’s or shared host node’s data is saved in host 
memory.

4 From the Content list, select the type of content contained in the node.Prel
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5 In the Write-to-read delay box, enter the write-to-read delay that you would 
like to apply to the node. For information on applying a write-to-read delay, see 
“Applying a write-to-read delay to a node” in the Matrox DSX Topology API User 
Guide.

6 In the Depth box, enter the node depth (number of previous frames to be kept in 
the node).

7 Expand the Video resolution list ( ). The New node resolution dialog box 
opens.

a Select the resolution, frame rate, bits per component, scan mode, and aspect 
ratio. 

b Click OK.

The video resolution of the node is displayed in the Video resolution field.

8 Select or enter the remaining settings for the node in the New card node 
settings (for a card node), New host node settings (for a host node), or New 
shared host node settings (for a shared host node) dialog box.

Remarks
$ If the VANC format is YUYV422 (Legacy), you must enter 10 VANC bits 

per component.

$ If the VANC format is Ancillary Data, you must enter 16 VANC bits per 
component.

9 Click OK. 

A new card, host node, or shared host node is added to the Topology view.

Note On an X.mio2 Plus, if you would like to save or remove a card node’s content 
to or from the permanent memory of a card, see “Using the Permanent memory 
manager” on page 20.
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Creating a compressed host node
1 Add a compressed host node. For information on the different ways to add a 

compressed host node, see “Adding items to a topology” on page 28. 

The New compressed host node settings dialog box opens.

2 In the Node name box, enter a name for the compressed host node.

3 From the Node content list, select the type of content contained in the 
compressed host node.

4 Expand the Video resolution list ( ). 

The New node resolution dialog box opens.

a Select the resolution, frame rate, bits per component, scan mode, and aspect 
ratio. 

b Click OK.

The video resolution of the compressed host node is displayed in the Video 
resolution field of the New compressed host node settings dialog box.

5 Click OK.

A new compressed host node is added to the Topology view.
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Creating an alias card node
1 Add an alias card node. For information on the different ways to add an alias card 

node, see “Adding items to a topology” on page 28. 

The New alias card node settings dialog box opens.

2 In the Alias node name box, enter a name for the alias card node.

3 From the topologies listed, select the card node whose data you would like to 
access.

Note You can select a card node located in any process.

4 Click OK.

A new alias card node is added to the Topology view.Prel
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Creating a link node
1 Add a link node. For information on the different ways to add a link node, see 

“Adding items to a topology” on page 28. 

The New link node settings dialog box opens.

2 In the Link node name box, enter a name for the link node.

3 From the Host node data to access list, select the host node whose data you 
would like to access.

Note You can select a host node located in any topology of the same process.

4 Click OK.

A new link node is added to the Topology view.
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Creating an input stream
Unlike other streams, you are not required to have a card node before creating an 
input stream. If you already have a card node, you can use it as the output of the input 
stream. Otherwise, you can create the card node at a different time and connect the 
input stream to it when required (see “Creating a node” on page 31). For more 
information on input streams, see “Input streams” in the Matrox DSX Topology API 
User Guide.

To create an input stream:

1 Add an input stream. For information on the different ways to add an input 
stream, see “Adding items to a topology” on page 28. 

The New input stream settings dialog box opens.

2 In the Input stream name box, enter a name for the input stream.

3 From the Output node list, select the card node to receive the input stream if a 
card node has already been created. Otherwise, select No output.

Note Even if a card node has already been created, you are not required to 
select it as the output node.
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4 From the Input connector list, select the SDI input connector for the input 
stream.

In the case of Ultra HD (UHD), select Multiple from the Input connector list. 
If required, expand the Input connector list ( ). The UHD input selection 
dialog box opens.

a From the Connector list, select the connector and from the corresponding 
Position list, select in which quadrant the image is to be placed.

b If the UHD image contains alpha, click UHD with alpha. Otherwise, click 
UHD.

c Click OK.

The input connector settings for the UHD image is displayed next to the Input 
connector list.

Note The selected SDI input connector will automatically be added to the 
topology and connected to the input stream. If you also want to use an AES/EBU 
input connector, you must add it manually and connect it to the input stream.

5 If you would like to use the card node’s resolution for the input stream, select 
Use node’s resolution. Otherwise, expand the Video resolution list ( ). 

Note If you selected No output from the Output node list in step 3, clear 
Use node’s resolution and expand the Video resolution list to select the 
resolution of the card node that you would like to connect to at a different time. 
However, you must make sure that the resolutions are the same when you connect 
the card node to the input stream.
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The New node resolution dialog box opens.

a Select the resolution, frame rate, bits per component, scan mode, and aspect 
ratio. 

b Click OK.

The video resolution of the input stream is displayed in the Video resolution 
field of the New input stream settings dialog box.

6 If required, enter values for:

$ Brightness The range is from -92.5 to 92.5.

$ Luma gain The range is from 0 to 2.

$ Hue The range is from 0 to 360.

$ Saturation The range is from 0 to 2.

7 If required, select any of the following: 

$ Allow super black Allows an input video signal that is below 7.5 IRE.

$ Allow super white Allows an input video signal that is above 100 IRE.

$ Enable chroma clipping Clips over-saturated chroma levels in the active 
portion of the input video signal.

$ Upscale Upscales the luminance range of the input key signal from 16-235 
to 0-255. If the video’s input stream is connected to a node containing YUV 
4:2:2 data, this option is ignored.

$ Offset Applies an offset to the luminance values so that the inverted key 
result falls within the 0-255 range. The offset can only be applied if both 
Invert and Upscale are selected. If the video’s input stream is connected to a 
node containing YUV 4:2:2 data, this option is ignored. 

$ Invert Inverts the luminance part of the key signal and key value. If the input 
stream is connected to a node containing YUV 4:2:2 data, this option is 
ignored. 
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8 From the Input stream mode list, select the type of time base correction to 
apply to the input stream. For more information on the input stream’s time base 
correction, see “Applying time base correction and audio resampling” in the 
Matrox DSX Topology API User Guide.

9 If required, select the audio pairs that you would like to mute.

10 Click OK.

A new input stream is added to the Topology view, and is connected to the selected 
video input connector and to the selected output card node, if an existing card node 
has been selected.

Note You can connect the input stream to a different audio input connector or 
node.
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Creating an output stream
Unlike other streams, you are not required to have a card node before creating an 
output stream. If you already have a card node, you can use it as the input to the 
output stream. Otherwise, you can create the card node at a different time and connect 
the output stream to it when required (see “Creating a node” on page 31). For more 
information on output streams, see “Output streams” in the Matrox DSX Topology 
API User Guide.

To create an output stream:

1 Add an output stream. For information on the different ways to add an output 
stream, see “Adding items to a topology” on page 28. 

The New output stream settings dialog box opens.

2 In the Output stream name box, enter a name for the output stream.
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3 From the Input node list, select the card node containing the data to be sent to 
the output stream if a card node has already been created. Otherwise, select No 
input.

Note Even if a card node has already been created, you are not required to 
select it as the input node.

4 From the Output connector list, select the SDI output connector for the output 
stream.

In the case of Ultra HD (UHD), select Multiple from the Output connector list. 
If required, expand the Output connector list ( ). The UHD output selection 
dialog box opens.

a From the Connector list, select the connector and from the corresponding 
Position list, select in which quadrant the image is to be placed.

b If the UHD image contains alpha, click UHD with alpha. Otherwise, click 
UHD.

c Click OK.

The output connector settings for the UHD image is displayed next to the 
Input connector list.

Note The selected SDI output connector will automatically be added to the 
topology and connected to the output stream. If you also want to use an 
AES/EBU output connector, you must add it manually and connect it to the 
output stream.

5 If you would like to use the card node’s resolution for the output stream, select 
Use node’s resolution. Otherwise, expand the Video resolution list ( ). 

Note If you selected No output from the Input node list in step 3, clear Use 
node’s resolution and expand the Video resolution list to select the resolution 
of the card node that you would like to connect to at a different time. However, 
you must make sure that the resolutions are the same when you connect the card 
node to the output stream.
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The New node resolution dialog box opens.

a Select the resolution, frame rate, bits per component, scan mode, and aspect 
ratio. 

b Click OK.

The video resolution of the output stream is displayed in the Video resolution 
field of the New output stream settings dialog box.

6 If required, select any of the following: 

$ Allow super white Allows an output video signal that is above 100 IRE.

$ Allow super black Allows an output video signal that is below 7.5 IRE.

$ Enable chroma clipping Clips over-saturated chroma levels in the active 
portion of the output video signal.

$ Edge sharpening filter Applies an edge sharpening filter to the digital 
output video. The filter reduces ringing artifacts that appear as a result of high 
amplitude transitions in the digital signal. 

$ Enable mechanical bypass Enables the mechanical bypass input to output 
connections depending on the card. For more information, see the Matrox DSX 
Topology API User Guide.

$ Advanced delay Indicates the delay (in frames) that will be applied to the 
output stream’s input. The value must be frame aligned. It must be less than 
the node depth minus the node’s write-to-read delay minus three frames. For 
more information, see the Matrox DSX Topology API User Guide.

$ Downscale Downscales the luminance range of the output key signal from 
0-255 to 16-235. If the video’s output stream is connected to a node containing 
YUV 4:2:2 data, this option is ignored.

$ Offset Applies an offset to the luminance values so that the inverted key 
result falls within the 16-235 range. The offset can only be applied if both 
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Invert and Downscale are selected. If the video’s output stream is connected 
to a node containing YUV 4:2:2 data, this option is ignored. 

$ Invert Inverts the luminance part of the output key signal and key value. If 
the video’s output stream is connected to a node containing YUV 4:2:2 data, 
this option is ignored. 

$ Enable video mixer Enables the in-line video mixer.

$ Shaped video Indicates that the video signal to the in-line video mixer 
from the auxiliary input (video from the output stream’s node) is already 
multiplied by its alpha plane. This option can only be applied if Enable video 
mixer is also selected.

$ VANC source Indicates the source for the vertical ancillary data. This 
option can only be applied if Enable video mixer is selected.

$ Audio and HANC source Indicates the source for the audio and horizontal 
ancillary data. This option can only be applied if Enable video mixer is 
selected.

$ Enable audio mixer Enables the in-line audio mixer.

$ Audio mixer aux. inverter Inverts the in-line audio mixer’s auxiliary input 
phase before being mixed. 

For more information on the output stream’s video and audio mixers, see “Using 
the output stream video and audio mixers” in the Matrox DSX Topology API User 
Guide.

7 If Enable audio mixer is selected:

a Select the input stream for the auxiliary input of the audio mixer from the 
Audio mixer aux. source selected list. The audio selected for the auxiliary 
input is mixed with the audio line input of the in-line audio mixer.

b If required, do one of the following to adjust the auxiliary master volume or 
line master volume: 

• Drag the Audio mixer aux. master volume or Audio mixer line master 
volume slider. 

• Enter a value in the text box.

• Click D to use the default value.

The volume is applied to all the auxiliary or line audio input channels. The 
master volume is changed gradually on all the audio channels at the same time. 
The volume is changed using a multiplication factor that ranges from 0 to 2. 
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c If required, select the audio track for which you would like to adjust the 
volume using the Audio mixer volumes scroll bar, and do one of the 
following:

• Drag the Audio line source or Audio aux. source slider.

• Enter a value in the text box.

• Click D to use the default value.

The volume is applied to specific auxiliary or line audio input channels. The 
volume is changed using a multiplication factor that ranges from 0 to 2 and is 
applied at the next zero-crossing.

Note Click Default all, to use the default settings for all the audio channel 
volumes.

8 Click OK. 

A new output stream is added to the Topology view, and is connected to the selected 
video output connector and to the selected input card node, if an existing card node 
has been selected.

Note You can connect the output stream to a different output connector or node.

Creating a transform stream
Before creating a transform stream, you must have a node for the input to the 
transform stream (see “Creating a node” on page 31). For more information on 
transform streams, see “Transform streams” in the Matrox DSX Topology API User 
Guide.

Remarks
• When a transform stream is created between two card nodes, your hardware must 

have an onboard scaler in order to transform the video.

• When a transform stream is created between two host nodes, the video is 
transformed using the card’s CPU scaler processing unit, if enabled.
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To create a transform stream:

1 Add a transform stream. For information on the different ways to add a transform 
stream, see “Adding items to a topology” on page 28. 

The New transform stream settings dialog box opens.

2 In the Transform stream name box, enter a name for the transform stream.

3 From the Input node list, select the node containing the data to be transformed.

4 From the Output node list, select the node to receive the transformed data.

Note If you would like to connect a node to the transform stream at a different 
time, select No output.

5 From the Content to process list, select the type of data that you would like the 
transform stream to process.

6 From the Transform type list, select the type of video data scaling to be 
performed by the transform stream.

7 From the Video processing list, select which data field to process.

8 If the vertical filter needs to be controlled manually, select Vertical filter 
manual ctrl and enter the value to use in the Vertical filter manual value box.
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Note When downscaling, to reduce aliasing without blurring the image, it is 
recommended to control the vertical filter manually.

9 If you would like to apply an advanced delay to the transform stream’s input 
node, enter the value to apply in the Advanced delay box. 

Remarks
$ The value must be frame aligned.

$ The advanced delay must be less than the node’s depth minus the node’s 
write-to-read delay minus three frames. 

For more information on applying an advanced delay to a node, see the Matrox 
DSX Topology API User Guide.

10 From the Src rectangle list, select the part of the node image to scale.

Note If you select Custom, enter the dimensions of the source rectangle in the 
boxes around the source rectangle or resize the source rectangle using the left, 
right, top, or bottom sliders.

11 From the Dest rectangle list, select the aspect ratio of the area to scale.

Note If you select Custom, enter the dimensions of the destination rectangle 
in the boxes around the destination rectangle or resize the destination rectangle 
using the left, right, top, or bottom sliders.

12 If audio processing is required, select Audio processing.

13 If you would like to clip VANC packets, select Clip all VANC packets. 
Otherwise, specify how to convert the VANC packets, if new bar data needs to be 
inserted using the destination rectangle, and if a new AFD code needs to be 
inserted.

Note If a new AFD code needs to be inserted, select the code from the 
AFD code list.

14 Click OK.

A new transform stream is added to the Topology view, and is connected to the 
selected input and output nodes.

Note A transform stream cannot be disconnected from its input node. However, 
you can connect the input to the transform stream to a different node.Prel
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Creating a mixer stream
Unlike other streams, you are not required to have a card node before creating a mixer 
stream. If you already have a card node, you can use it as the output of the mixer 
stream. Otherwise, you can create the card node at a different time and connect the 
mixer stream to it when required (see “Creating a node” on page 31). For information 
on mixer streams, see “Mixer streams” in the Matrox DSX Topology API User Guide.

Note An onboard compositor is required to create a mixer stream.

To create a mixer stream:
1 Add a mixer stream. For information on the different ways to add a mixer stream, 

see “Adding items to a topology” on page 28. 

The New mixer stream settings dialog box opens.

2 In the Mixer stream name box, enter a name for the mixer stream.

3 From the Output node list, select the card node that will receive the mixer 
stream.

4 From the Background node list, select No background, or select the 
background layer that you would like the mixer stream to apply to the output 
node.

Note A background layer can only be applied if Background handling (see 
below) is Wait and copy.

Prel
im

ina
ry
pter 2, Using mvTopologyBuilder to Manage Topologies



49
5 From Content to process list, select the type of data that you would like the 
mixer stream to process.

6 From the Composition mode list, select the type of composition that you would 
like the mixer stream to apply to the output node.

7 From the Background handling list, select whether you would like the mixer 
stream to apply a background color or background image.

$ Select Color to apply a background color.

$ Select Wait and copy to apply a background image using the selected 
background node.

Note Can only be applied if Composition mode is Downstream.

8 From the Background color list, select the color that you would like the mixer 
stream to apply to the background.

Note Can only be applied if Composition mode is Downstream and 
Background handling is Color.

9 If you would like the mixer stream to generate video that is already multiplied by 
its alpha, select Shape output.

Note Can only be applied if Composition mode is Upstream.

10 If you would like to apply an ARGB filter on the background layer of the mixer 
stream, select Background ARGB filter.

Note Can only be applied if Background handling is Wait and copy and 
the Background node was created with a Video surface format of ARGB 
graphic.

11 If you would like to apply an advanced delay to the background node of the 
mixer stream, enter the value to apply in the Background advanced delay box.

Remarks
$ The value must be frame aligned both at the input and output.

$ The advanced delay must be less than the node’s depth minus the node’s 
write-to-read delay minus three frames. 

For more information on applying an advanced delay to a node, see the Matrox 
DSX Topology API User Guide.

12 If you would like to select audio from one of the input layers, select Process 
audio and enter the audio layer to apply to the mixer stream’s output in the 
Audio input select box.

Remarks
$ The values range from zero (background) to the number of layers, inclusively.

$ If the Composition mode is Upstream, zero cannot be used.
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13 If you would like to select VANC data from one of the input layers, select 
Process VANC and enter the VANC layer to apply to the mixer stream’s output 
in the VANC input select box.

Remarks
$ The values range from zero (background) to the number of layers, inclusively.

$ If the Composition mode is Upstream, zero cannot be used.

14 Click OK.

A new mixer stream is added to the Topology view, and is connected to the selected 
output card node (if an existing card node has been selected), and if applicable, the 
selected background layer. The input nodes can then be connected to the mixer stream 
layers.

Note If you selected a background node, you cannot disconnect it from the mixer 
stream. However, you can connect it to a different stream.
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Creating a reader stream
Before creating a reader stream, you must have a host node for the output of the 
reader stream (see “Creating a node” on page 31). For more information on reader 
streams, see “Reader streams” in the Matrox DSX Topology API User Guide.

To create a reader stream:

1 Add a reader stream. For information on the different ways to add a reader 
stream, see “Adding items to a topology” on page 28. 

The New reader stream settings dialog box opens.

2 In the Reader name box, enter a name for the reader stream.

3 If you would like the VANC data in the file to be returned when seeking, select 
Process VANC on seek.

For more information on VANC processing, see “VANC data processing” in the 
Matrox DSX Topology API User Guide.

4 If you would like the audio data in the file to be returned when seeking, select 
Process audio on seek.

5 If you would like to apply a time delay instant replay, select TDIR.

6 From the Output host node list, select the host node that will receive the reader 
stream data.
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7 From the Content to process list, select the type of data that you would like the 
reader stream to process.

8 In the Video file path box, select the file name and location of the file to read. If 
required, click Browse to locate the file.

Note After you select a file, information about the file is added to the Basic 
information field of the New reader stream settings dialog box. Only 
available information is added.

9 If you would like the reader stream to play separate audio files, click + to select 
the file name and location of the audio file to stream.

Remarks
$ If you would like to remove an audio file from the list, click -.

$ Click Move up and/or Move down to rearrange the order in which to play 
the audio files.

10 If you would like to repeat the last decompressed frame at the output, select 
Repeat last frame at end of play.

11 From the NTSC closed caption list, select the format in which to output the 
NTSC closed captioning.

12 In the Read ahead box, enter the maximum number of frames that can be read 
ahead of time.

Note This value cannot be zero.

13 In the Read ahead threshold box, enter the number of frames that will be used 
to signal the reader stream when to get more frames from the file.

Note If this value is set to zero, the reader stream uses half the value entered in 
the Read ahead box.

14 In the Cue next element box, enter the minimum number of frames required 
before the next element is cued.

Remarks
$ The recommended value is four seconds (in frames).

$ If this value is too small, frames may be skipped as a result.

15 In the In point box, enter the first frame to be read in the file.

16 In the Out point box, enter the last frame of the element in the file.

Note This value is exclusive. This means that a trim from 0 to 200 will play 
frames 0 to 199.

17 In the Duration box, enter the number of frames to output.

18 From the Slow-motion type list, select which slow-motion algorithm to use.
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19 If you would like to automatically update the duration, select Automatically 
update duration.

20 Click OK. 

A new reader stream is added to the Topology view, and is connected to the selected 
host node. 

Note A reader stream cannot be disconnected. However, you can connect it to a 
different host node.

Creating a writer stream
Before creating a writer stream, you must have a host node for the input to the writer 
stream (see “Creating a node” on page 31). For more information on writer streams, 
see “Writer streams” in the Matrox DSX Topology API User Guide.

To create a writer stream:

1 Add a writer stream. For information on the different ways to add a writer stream, 
see “Adding items to a topology” on page 28. 

The New writer stream settings dialog box opens.

2 In the Writer name box, enter a name for the writer stream.

3 From the Host node list, select the host node that will provide data to the writer 
stream.
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4 In the Destination file path box, specify the location and name for the file to be 
created. If required, expand the path ( ) to specify the location. 

To determine which file formats are supported, see “DSX Supported Media File 
Formats” in the Matrox DSX File I/O and Codec Information User Guide.

5 If you would like to capture video data, select Video and from the list, select the 
video codec to use.

Note If the video codec that you would like to use does not appear in the list, 
select Additional CODECs and click  to configure the writer stream codec.

6 If you would like to capture audio data, select Audio.

From the list, select the audio codec to use and click  to configure the audio 
codec.

$ If AAC audio is selected, the AAC options dialog box opens.

• From the Stereo encoding mode list, select the type of stereo encoding to 
apply.

• From the Shaping model list, select the type of noise shaping model to 
apply.

• From the Output format list, select the format in which to output the AAC 
audio stream.

• Drag the Target bit rate slider to set the target bit rate.

• Click OK.

The AAC audio codec is configured.
Prel

im
ina

ry
pter 2, Using mvTopologyBuilder to Manage Topologies



55
$ If PCM audio is selected, the PCM options dialog box opens.

• From the Bits per sample list, select the valid bits per sample to apply.

• Click OK.

The PCM audio codec is configured.

7 If you would like to capture VANC data, select VANC and from the Location 
list, select where the VANC data is located. 

Note VANC data can be captured only if Video is selected.

8 If you would like to capture to other files, select File switching and in the Each 
box, enter how many frames to capture to each file.

9 If you would like to apply time delay instant replay, select TDIR and in the 
Update interval box, enter the flush frequency in seconds.

10 In the Reserved space for end of disk box, enter the amount of disk space to 
reserve before the writer stream determines that the end of the disk has been 
reached.

11 Click OK.

A new writer stream is added to the Topology view, and is connected to the selected 
host node.

Note A writer stream cannot be disconnected. However, you can connect it to a 
different host node.Prel
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Creating a compressed writer stream
Before creating a compressed writer stream, you must have a compressed host node 
for the input to the compressed writer stream (see “Creating a node” on page 31). For 
more information on compressed writer streams, see “Compressed writer streams” in 
the Matrox DSX Topology API User Guide.

To create a compressed writer stream:

1 Add a compressed writer stream. For information on the different ways to add a 
compressed writer stream, see “Adding items to a topology” on page 28. 

The New compressed writer stream settings dialog box opens.

2 In the Name box, enter a name for the compressed writer stream.

3 From the Compressed writer type list, select the type of compressed writer 
stream to create.

4 If you would like to capture compressed video and VANC data, select 
Compressed video and from the list, select the compressed host node 
containing the compressed video and VANC data.

5 If you would like to capture compressed audio data, select Compressed audio 
and from the list, select the compressed host node containing the compressed 
audio data.

6 In the File name box, specify the location and name for the file to be created. If 
required, click  to specify the location and name. 

7 In the Reserved space for end of disk box, enter the amount of disk space to 
reserve before the compressed writer stream determines that the end of the disk 
has been reached.
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8 If you would like to delete the file when you close the Topology view, select 
Delete file.

9 Click OK.

A new compressed writer stream is added to the Topology view, and is connected to 
the selected compressed host node.

Note A compressed writer stream cannot be disconnected. However, you can 
connect it to a different compressed host node.

Creating a decoder stream
Before creating a decoder stream, you must have a compressed host node and a host 
node. The compressed host node is required for the input to the decoder stream and 
the host node is required for the output of the decoder stream (see “Creating a node” 
on page 31). For more information on decoder streams, see “Decoder streams” in the 
Matrox DSX Topology API User Guide.

To create a decoder stream:

1 Add a decoder stream. For information on the different ways to add a decoder 
stream, see “Adding items to a topology” on page 28. 

The New decoder stream settings dialog box opens.

2 In the Decoder stream name box, enter a name for the decoder stream.

3 From the Input node list, select the input compressed host node containing the 
data to be decoded.

4 From the Output node list, select the output host node to receive the 
decompressed data from the decoder stream.

5 From the Decompression type list, select the codec that will be used to decode 
the stream.
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6 Click OK.

A new decoder stream is added to the Topology view, and is connected to the selected 
nodes.

Note A decoder stream cannot be disconnected. However, you can connect it to 
different nodes.

Creating a de-interlacer stream
Before creating a de-interlacer stream, you must have a card node for the input to the 
de-interlacer stream (see “Creating a node” on page 31). For more information on 
de-interlacer streams, see “De-interacer streams” in the Matrox DSX Topology API 
User Guide.

Note An onboard de-interlacer is required to create a de-interlacer stream.

To create a de-interlacer stream:

1 Add a de-interlacer stream. For information on the different ways to add a 
de-interlacer stream, see “Adding items to a topology” on page 28. 

The New de-interlacer stream settings dialog box opens.

2 In the De-interlacer stream name box, enter a name for the de-interlacer 
stream.

3 From the Input node list, select the card node containing the data from which 
you would like to remove interlace or motion artifacts.
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4 From the Output node list, select the output card node that will receive the 
de-interlaced data from the de-interlacer stream.

Remarks
$ If you would like to connect a card node to the transform stream at a different 

time, select No output.

$ The output card node’s resolution must be the same as the input card node’s 
resolution, and the output card node’s frame rate can be the same or twice the 
input card node’s frame rate. For supported video input and output card node 
formats, see “De-interlacer streams” in the Matrox DSX Topology API User 
Guide.

5 From the Content to process list, select the type of data that you would like the 
reader stream to process.

6 If you would like to show the motion vectors of the de-interlacing process in the 
output of the de-interlacer stream, select Show motion vectors.

7 If you would like for the de-interlacer stream to process the input node’s ancillary 
data, select Process VANC.

8 If you would like the analog line 21 to be converted to Matrox Ancillary Data 
VANC format, select Convert analog CEA-608 to digital.

9 If you would like for the de-interlacer stream to process the input node’s audio, 
select Process audio.

10 If required, in the Input node advanced delay box, enter the delay (in 
nanotime) to apply to the de-interlacer stream’s input.

Remarks
$ The value must be frame aligned.

$ The advanced delay must be less than the node’s depth minus the node’s 
write-to-read delay minus three frames. 

For more information on applying an advanced delay to a node, see the Matrox 
DSX Topology API User Guide.

A new de-interlacer stream is added to the Topology view, and is connected to the 
selected card node(s).

Note A de-interlacer stream cannot be disconnected from its input node. However, 
you can connect the input to the de-interlacer stream to a different node.Prel
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Creating an echo stream
Before creating an echo stream, you must have a compressed host node and a host 
node. One is for the input to the echo stream and the other is for the output of the echo 
stream (see “Creating a node” on page 31). For more information on echo streams, 
see “Echo streams” in the Matrox DSX Topology API User Guide.

Remarks
• An echo stream is used to propagate VANC data without altering it.

• When defining the compressed host node settings, select VANC from the Node 
content list.

To create an echo stream:

1 Add an echo stream. For information on the different ways to add an echo stream, 
see “Adding items to a topology” on page 28. 

The New echo stream settings dialog box opens.

2 In the Echo stream name box, enter a name for the echo stream.

3 From the Echo direction list, select the direction you would like the echo stream 
to propagate the VANC data. The direction can be from a host node to a 
compressed host node, or vice-versa.

4 From the Input node list, select the node containing the VANC data that you 
would like to propagate.

Note If you select a host node as the input node, then you must select a 
compressed host node as the output node, and vice-versa.

5 From the Output node list, select the node to which you would like to propagate 
the VANC data.

Note If you select a host node as the output node, then you must select a 
compressed host node as the input node, and vice-versa.

6 Click OK.
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A new echo stream is added to the Topology view, and is connected to the selected 
nodes.

Note An echo stream cannot be disconnected. However, you can connect it to 
different nodes.

Creating an encoder stream
Before creating an encoder stream, you must have a host node and a compressed host 
node. The host node is required for the input to the encoder stream and the 
compressed host node is required for the output of the encoder stream (see “Creating 
a node” on page 31). For more information on echo streams, see “Encoder streams” in 
the Matrox DSX Topology API User Guide.

Note When defining the compressed host node settings, select the type of content 
required by the encoder stream from the Node content list. For example, if you are 
using the encoder stream to encode video, select Video from the Node content list. 

To create an encoder stream:

1 Add an encoder stream. For information on the different ways to add an encoder 
stream, see “Adding items to a topology” on page 28. 

The New encoder stream settings dialog box opens.

2 In the Encoder stream name box, enter a name for the encoder stream.

3 From the Input node list, select the input host node containing the data that you 
would like to compress.

4 From the Output node list, select the output compressed host node that will 
receive the compressed data from the encoder stream.

5 If you would like the encoder stream to process data, select Process data.

6 If you would like to apply an advanced delay to the encoder stream’s input node, 
enter the value to apply in the Advanced delay box.
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Remarks
$ The value must be frame aligned.

$ The advanced delay must be less than the node’s depth minus the node’s 
write-to-read delay minus three frames. 

For more information on applying an advanced delay to a node, see the Matrox 
DSX Topology API User Guide.

7 From the Compression type list, select the codec that will be used to compress 
the stream.

8 Click OK.

A new encoder stream is added to the Topology view, and is connected to the selected 
nodes.

Note An encoder stream cannot be disconnected. However, you can connect it to 
different nodes.

Creating a muxer stream
Before creating a muxer stream, you must have three compressed host nodes. Two of 
which are for the input to the muxer stream and the other is for the output of the 
muxer stream (see “Creating a node” on page 31). For more information on muxer 
streams, see “Muxer streams” in the Matrox DSX Topology API User Guide.

Remarks
• One of the compressed host nodes to be used to connect to the input of the muxer 

stream must contain compressed video, while the other must contain compressed 
audio.

• The compressed host node to be used to connect to the output of the muxer 
stream must contain a compressed MPEG-2 transport stream (TS).
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To create a muxer stream:

1 Add a muxer stream. For information on the different ways to add a muxer 
stream, see “Adding items to a topology” on page 28. 

The New muxer stream settings dialog box opens.

2 In the Muxer stream name box, enter a name for the muxer stream.

3 From the Video input node list, select the compressed host node containing the 
compressed video data that you would like to include in the compressed 
MPEG-2 TS muxed buffer.

4 From the Audio input node list, select the compressed host node containing the 
compressed audio data that you would like to include in the compressed 
MPEG-2 TS muxed buffer.

5 From the Output node list, select the compressed host node that will receive the 
compressed MPEG-2 TS muxed buffer.

6 In the Program ID box, enter the program packet ID contained in the stream.

7 In the Video PID box, enter the packet ID of the video elementary stream.

8 In the Audio PID box, enter the packet ID of the audio elementary stream.

9 In the PCR PID box, enter the packet ID of the Program Clock Reference (PCR) 
elementary stream.
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10 From the Bit rate option list, select the bit rate encoding option of the stream.

Note The recommended option for streaming is variable bit rate (VBR).

11 If you would like the muxer stream to multiplex compressed VANC data into the 
compressed MPEG-2 TS muxed buffer, select Process VANC and:

$ From the Input node list, select the compressed host node containing the 
compressed VANC data.

$ In the PID box, enter the packet ID of the VANC elementary stream.

$ From the Type list, select the type of elements to process in the VANC. 

Note Currently only SCTE 35 streams are supported.

12 Click OK.

A new muxer stream is added to the Topology view, and is connected to the selected 
compressed host nodes.

Note An muxer stream cannot be disconnected. However, you can connect it to 
different compressed host nodes.
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Creating an RTP sender stream
Before creating an RTP sender stream, you must have a compressed host node for the 
input to the RTP sender stream (see “Creating a node” on page 31) containing 
compressed MPEG-2 transport stream (TS) muxed buffers. For more information on 
RTP sender streams, see “RTP sender streams” in the Matrox DSX Topology API User 
Guide.

To create an RTP sender stream:

1 Add an RTP sender stream. For information on the different ways to add an RTP 
sender stream, see “Adding items to a topology” on page 28. 

The New RTP sender stream settings dialog box opens.

2 In the RTP sender stream name box, enter a name for the RTP sender stream.

3 From the Surface format list, select the format of the data to send.

Note Currently only compressed MPEG-2 TS muxed buffers are supported.

4 In the Network interface IP address box, enter the IP address (IPV4) of the 
network card to be used for Real-time Transport Protocol (RTP) transmission.

Note An RTP sender stream can only be created if the IP address entered is the 
same as the system’s IP address.
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5 In the Remote IP address box, enter the IP address to which data will be 
streamed.

Note A multicast address can be used. However, it will only stream content to 
the systems within the same subnet as the source system.

6 In the Source port box, enter the IP port to use on the source side.

Note The value entered must be an even number.

7 In the Destination port box, enter the IP port to use on the destination side.

Note The value entered must be an even number.

8 From the IP protocol list, select the IP protocol for streaming.

Note Currently only User Datagram Protocol (UDP) is supported.

9 In the MTU box, enter the Maximum Transmission Unit (MTU) to use for 
connection.

Note The maximum value is 1500.

10 In the TTL box, enter the time in which RTP packets can be used.

Note The maximum value is 255.

11 From the Input compressed host node list, select the compressed host node 
containing the compressed MPEG-2 TS muxed buffers that you would like to use 
for streaming over the Internet.

12 Click OK.

A new RTP sender stream is added to the Topology view, and is connected to the 
selected compressed host node.

Note An RTP sender stream cannot be disconnected. However, you can connect it 
to a different compressed host node.
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Creating an RTP receiver stream
Before creating an RTP receiver stream, you must have a compressed host node for 
the output of the RTP receiver stream (see “Creating a node” on page 31). For more 
information on RTP receiver streams, see “RTP receiver streams” in the Matrox DSX 
Topology API User Guide.

To create an RTP receiver stream:

1 Add an RTP receiver stream. For information on the different ways to add an RTP 
receiver stream, see “Adding items to a topology” on page 28. 

The New RTP receiver stream settings dialog box opens.

2 In the RTP receiver stream name box, enter a name for the RTP receiver 
stream.

3 From the Output compressed host node list, select the compressed host node 
to which you would like to send the compressed MPEG-2 transport stream (TS) 
data.

4 From the Surface format list, select the format of the multiplexed TS data 
which can be received.

Note Currently only compressed MPEG-2 TS muxed buffers can be received.

5 From the Buffering mode list, select the latency required for the buffering mode 
of the RTP receiver stream.
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6 From the IP protocol list, select the IP protocol the RTP receiver stream uses to 
receive the multiplexed TS data.

Note Currently only User Datagram Protocol (UDP) is supported.

7 From the Source list, select the type of connection the RTP receiver stream uses.

$ If Network interface is selected, enter values for:

• Network interface IP address Indicates the IP address (IPV4 or IPV6) 
of the network card to be used for Real-time Transport Protocol (RTP) 
transmission.

• Remote IP address Indicates the IP address from which data will be 
received.

A multicast address can be used.However, it will only stream content to the 
systems within the same subnet as the source system.

• Destination port Indicates the IP port to use on the destination side. The 
value entered must be an even number.

• Source port Indicates the IP port to use on the source side. The value 
entered must be an even number.

• MTU Indicates the Maximum Transmission Unit (MTU) to use for 
connection. The maximum value is 1500.

• TTL Indicates the time in which RTP packets can be used. The maximum 
value is 255.

$ If SAP is selected, enter the following:

• Session name Indicates the name of the Session Announcement 
Protocol (SAP) data that will be used to connect to the remote host.

• Timeout Indicates the maximum time (in milliseconds) to wait for the 
RTP receiver stream to connect to the remote host.

$ If SDP is selected, do one of the following:

• In the SDP data box, enter a name for the Session Description Protocol 
(SDP) that will be used to establish connection and click Save.

• To use a previously saved SDP data file, click Load.

8 Click OK.

A new RTP receiver stream is added to the Topology view, and is connected to the 
selected compressed host node.

Note An RTP receiver stream cannot be disconnected. However, you can connect it 
to a different compressed host node.
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Creating a transfer stream
Before creating a transfer stream, you must have a card node and a host node. One is 
for the input to the transfer stream and the other is for the output of the transfer stream 
(see “Creating a node” on page 31). For more information on transfer streams, see 
“Transfer streams” in the Matrox DSX Topology API User Guide.

Remarks
• A transfer stream is used to transfer data between onboard memory and host 

memory without any modification.

• In the case where the resolution of the card node is PsF, the VANC data is 
converted to progressive when transferred to a host node (or vice-versa).

To create a transfer stream:

1 Add a transfer stream. For information on the different ways to add a transfer 
stream, see “Adding items to a topology” on page 28. 

The New transfer stream settings dialog box opens.

2 In the Transfer stream name box, enter a name for the transfer stream.

3 From the Transfer direction list, select the direction you would like the transfer 
stream to propagate the data. The direction can be from a card node to a host 
node, or vice-versa.

4 From the Input node list, select the node containing the data that you would like 
to propagate.

Note If you select a host node as the input node, then you must select a card 
node as the output node, and vice-versa.
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5 From the Output node list, select the node to which you would like to propagate 
the data.

Note If you select a host node as the output node, then you must select a card 
node as the input node, and vice-versa.

6 From the Content to process list, select the type of data in the stream to 
process.

7 If required, in the Advanced delay box, enter the delay (in nanotime) to apply to 
the transfer stream’s input.

Remarks
$ The value must be frame aligned both at the input and output.

$ The advanced delay must be less than the node’s depth minus the node’s 
write-to-read delay minus three frames. 

For more information on applying an advanced delay to a node, see the Matrox 
DSX Topology API User Guide.

8 Click OK.

A new transfer stream is added to the Topology view, and is connected to the selected 
nodes.

Note A transfer stream cannot be disconnected. However, you can connect it to 
different nodes.
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Creating a CG stream
A CG stream is a software item that can be used to generate video and audio. For 
more information on software items, see “Application items” on page 9.

Before creating a CG stream, you must have a node for the output of the CG stream 
(see “Creating a node” on page 31).

Note You can use a host or card node as the output node.

To create a CG stream:

1 Add a CG stream. For information on the different ways to add a CG stream, see 
“Adding items to a topology” on page 28. 

The New CG stream settings dialog box opens.

2 In the Stream name box, enter a name for the CG stream.

3 From the Video image list, select the type of video for the CG stream. To select 
a different video image, expand the Video image list ( ) to specify the location 
and name of the video image that you would like to use. 

4 From the Output node list, select the node that you would like to use for the CG 
stream. 

5 If you would like to generate audio tones for the CG stream, select Audio 
generation and click Customize to customize the audio. Prel
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The Audio generation parameters dialog box opens.

a Do one of the following to set the amplitude, frequency, and phase:

• Drag the appropriate slider accordingly for the selected audio track. 

• Enter a value in the appropriate box for the selected audio track. 

• Click Reset to reset the value to the default value for the selected audio 
track.

• Click Same to apply the current values to all the audio tracks.

• Click Ramp to use the hard-coded values for all the audio tracks.

b Click OK.

The audio generation parameters will be used when creating the CG stream.

6 From the Time code generation list, select the type of time code to generate.

7 If you would like to generate a moving bar for the CG stream, select Moving bar 
generation.

8 Click OK.

A new CG stream is added to the Topology view, and is connected to the selected 
node.Prel
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Creating a Live window
A Live window is a software item that is used to display the contents of a card or host 
node. For more information on the Live window, see “Live window item” on page 10.

To create a Live window item:

1 Add a Live window. For information on the different ways to add a Live window, 
see “Adding items to a topology” on page 28. 

The New Live window settings dialog box opens.

2 In the Live window name box, enter a name for the Live window.

3 Click OK.

A new Live window is added to the Topology view. It can then be connected to 
any card or host node.

Note If a Live window is closed, choose View > Live window to open it again.
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Creating a watchdog
A watchdog is a monitoring feature that can alter the state of the card and the way that 
the card processes data. For more information on watchdogs, see “Using the 
watchdog feature” in the Matrox DSX Topology API User Guide.

To create a watchdog:

1 In the Card pane toolbar, select New from the Watchdog menu ( ). 

The New watchdog dialog box opens.

2 In the Watchdog name box, enter a name for the watchdog.

3 From the Card list, select the card for which you would like to create a watchdog.

4 Click OK.

A new watchdog is added to the tree structure of the selected card.

5 Select the newly created watchdog and edit the Watchdog properties pane as 
follows: 

$ If you would like to pulse the watchdog, select Pulse event.

$ If you would like to enable a timeout after which the watchdog will be 
triggered, select Enable timeout. To use this feature, clear Force topology.

$ In the Watchdog timeout box, enter the amount of time (in seconds) that 
needs to elapse before the watchdog is triggered. To use this feature, select 
Enable timeout.

$ If you would like to force the watchdog to trigger immediately, select Force 
topology.

$ From the GPI input pin list, select the General Purpose Interface (GPI) input 
pin that you would like to use to trigger the watchdog. To use this feature, clear 
Force topology. If you do not want to use a GPI input pin, select Invalid.

$ From the GPI input trigger type list, select the type of GPI signal that will 
activate the selected GPI input pin. 

$ From the GPI output pin list, select the GPI output pin that you would like to 
activate when the watchdog is triggered. If you do not want to use a GPI output 
pin, select Invalid.
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$ From the GPI output trigger type list, select the type of GPI signal that the 
selected GPI output pin will generate. 

$ In the Output pin pulse box, enter the duration of the pulse (in nanoseconds) 
on the specified GPI output pin. To use this feature, select Falling edge or 
Rising edge from the GPI output trigger type list.

$ From the Topology to load list, select a previously created system topology 
that you would like to load when the watchdog is triggered. For more 
information on creating a system topology, see “Creating a new system 
topology” on page 27. 

The watchdog properties are edited if any changes are made in the Watchdog 
properties pane. 

Note If you would like to add or remove a watchdog to or from the default state of 
a card, see “Using the Permanent memory manager” on page 20.Prel
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Your notes
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Working with System Topologies

This chapter provides examples 
on how to work with system 
topologies. The examples are 
simple, but can be extended to 
more complex uses.
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Creating playback topologies
This section explains how to create a simple playback topology, as well as a 
simultaneous HD/SD playback topology with a Live window using examples. 

Creating a simple playback topology
To create a simple playback topology:

1 Create a new system topology (see “Creating a new system topology” on 
page 27).

2 Create a card node with the following settings:

$ Node name: Card node 1.

$ Content: Video and audio.

$ Write-to-read delay: 1 frame.

$ Depth: 8 frames.

$ Video resolution: 1080i.

$ Video surface format: YUYV 422.

$ Video colorimetry: ITUR BT 709.

$ Audio channel type: Stereo.

$ Audio data type: PCM.

$ Audio bits per sample: 24 bits in 32 bits.

$ Any VANC format.

For information on creating a card node, see “Creating a node” on page 31.

3 Create an output stream with the following settings:

$ Input node: Card node 1.

$ Output connector: SDI OUT A.

For information on creating an output stream, see “Creating an output stream” on 
page 41.

4 Create a host node (Node name: Host node 1) with the same settings as the card 
node in step 2.

5 Create a reader stream with the following setting:

$ Output host node: Host node 1.

$ File path: Any 1080i file containing stereo audio.

For information on creating a reader stream, see “Creating a reader stream” on 
page 51.

6 Create a transfer stream between the host node and the card node in which the 
transfer direction is from host node to card node. For more information on 
creating a transfer stream, see “Creating a transfer stream” on page 69.
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A simple playback topology is created as shown in the following figure.

7 Click the reader stream and click Play ( ) in the Transport pane to start the 
simple playback.

Creating a simultaneous HD/SD playback topology 
with a Live window
To create a simultaneous HD/SD playback topology with a Live window:

1 Create a simple HD playback topology as explained in steps 1 to 6 of “Creating a 
simple playback topology” on page 78, with an advanced delay of one frame 
applied to the output stream in the Properties pane.

2 Create an SD card node with the following settings:

$ Node name: Card node 2.

$ Content: Video and audio.

$ Write-to-read delay: 1 frame.

$ Depth: 8 frames.

$ Video resolution: NTSC.

$ Video surface format: YUYV 422.

$ Video colorimetry: ITUR BT 601.

$ Audio channel type: Stereo.

$ Audio data type: PCM.

$ Audio bits per sample: 24 bits in 32 bits.

$ Any VANC format.

3 Create a transform stream to downscale from HD to SD with the following 
settings:

$ Transform stream name: Transform 1.

$ Input node: Card node 1.

$ Output node: Card node 2.

$ Transform type: Region.

$ Source rectangle: Full screen.

$ Destination rectangle: Keep aspect ratio.

$ Select Audio processing.
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$ Any VANC format.

For information on creating a transform stream see “Creating a transform stream” 
on page 45.

4 Create an output stream with the following settings:

$ Input node: Card node 2.

$ Output connector: SDI OUT B.

For information on creating an output stream, see “Creating an output stream” on 
page 41.

5 Create a Live window and connect it to the output of Card node 1. For 
information on creating a Live window, see “Creating a Live window” on 
page 73.

A simultaneous HD/SD playback topology with a Live window is created as 
shown in the following figure.

6 Click Play/Record all in the Main toolbar to start the playback.Prel
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Creating capture topologies
This section explains how to create a simple capture topology, as well as a 
simultaneous HD/SD capture topology with a Live window using examples.

Creating a simple capture topology
To create a simple capture topology:

1 Set the Genlock source to Internal or SDI input A.

Note When using time base correction, if repeated frames are not desirable, 
select SDI input A. For more information on time base correction, see “Applying 
time base correction and audio resampling” in the Matrox DSX Topology API 
User Guide.

2 Create a new system topology (see “Creating a new system topology” on 
page 27).

3 Create a card node with the following settings:

$ Node name: Card node 1.

$ Content: Video and audio.

$ Write-to-read delay: 1 frame.

$ Depth: 8 frames.

$ Video resolution: 1080i.

$ Video surface format: YUYV 422.

$ Video colorimetry: ITUR BT 709.

$ Audio channel type: Stereo.

$ Audio data type: PCM.

$ Audio bits per sample: 24 bits in 32 bits.

$ Any VANC format.

For information on creating a node, see “Creating a node” on page 31.

4 Create an input stream with the following settings:

$ Output node: Node 1.

$ Input connector: SDI IN A.

For information on creating an input stream, see “Creating an input stream” on 
page 37.

5 Create a host node (Node name: Host node 1) with the same settings as the card 
node in step 3.
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6 Create a writer stream connected to Host node 1 with the following settings:

$ File path: Location and .avi file name of your choice.

$ Select Audio.

$ Clear VANC.

For more information on creating a writer stream, see “Creating a writer stream” 
on page 53.

7 Create a transfer stream between the card node and the host node in which the 
transfer direction is from card node to host node. For more information on 
creating a transfer stream, see “Creating a transfer stream” on page 69.

A simple capture topology is created as shown in the following figure.

8 Click Play/Record all in the Main toolbar to start recording.

Creating a simultaneous HD/SD capture topology 
with a Live window
To create a simultaneous HD/SD capture topology with a Live window:

1 Create a simple HD capture topology as explained in steps 1 to 7 of “Creating a 
simple capture topology” on page 81.

2 Create an SD host node with the following settings:

$ Node name: Host node 2.

$ Content: Video and audio.

$ Write-to-read delay: 1 frame.

$ Depth: 8 frames.

$ Video resolution: NTSC.

$ Video surface format: YUYV 422.

$ Video colorimetry: ITUR BT 601.

$ Audio channel type: Stereo.

$ Audio data type: PCM.

$ Audio bits per sample: 24 bits in 32 bits.

$ Any VANC format.
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3 Create a transform stream to downscale from HD to SD with the following 
settings:

$ Transform stream name: Transform 1.

$ Input node: Host node 1.

$ Output node: Host node 2.

$ Transform type: Region.

$ Source rectangle: Full screen.

$ Destination rectangle: Keep aspect ratio.

$ Select Audio processing.

$ Any VANC format.

For information on creating a transform stream, see “Creating a transform 
stream” on page 45.

4 Create another writer stream connected to Host node 2 with the following 
settings:

$ File path: Location and .avi file name of your choice.

$ Select Audio.

$ Clear VANC.

5 Create a Live window stream and connect it to the output of Host node 1. For 
more information on creating a Live window, see “Creating a Live window” on 
page 73.
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An HD/SD capture topology with a Live window topology is created as shown in 
the following figure.

Note The content of the writers will not be synchronized because the 
transform stream’s output node produces a write-to-read delay of one frame.

6 Click Play/Record all in the Main toolbar to start recording.
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